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Chapter2: Creating a Task List  
(First part) 

 



 tasks represent the work to be done to accomplish the 

goals of the project. Tasks describe project work in terms of 

sequence, duration, and resource requirements. In Project, there 

are several different kinds of tasks. These include summary tasks, 

subtasks, and milestones. More broadly, what are called tasks in 

Project are sometimes also called activities or work packages.  

  we manage the scheduling of tasks in two different ways: 

  

● Enter tasks as manually. 

● Work with automatically scheduled tasks. 

Creating a Task List  



Creating a New Project Plan:  

 A project plan is a model that you construct of some aspects 

of a project you are anticipating (توقع) —what you think will happen, 

or what you want to happen. This model focuses on tasks, 

resources, time , and possibly their associated costs.  

 Project focuses primarily on time. You might know the 

planned start date of a project, the planned finish date, or both.  

 When working with Project, you specify only one date, 

not both: the project start date or the project finish date. Why? 

Because after you enter the project start or finish date and the 

durations of the tasks, Project calculates the other date for you. 

 Remember that Project is not just merely a static 

repository of your schedule information or a Gantt chart 

drawing tool; it is an active scheduling engine  

Creating a Task List:  



 Most projects should be scheduled from a start date, even 

if you know that the project should finish by a certain deadline 

date.  

 Scheduling from a start date causes all tasks to start as 

soon as possible, and it gives you the greatest scheduling 

flexibility.  

Creating a Task List:  

1. Click the File tab.  

2. Click the New tab.  

    Project displays your  

    options for creating a  

    new project plan.  

Start Project: 



These options include using templates installed with Project or 

available on the Web.  

3. Under Available Templates, make sure that Blank  

    project is selected, and then click the Create  

    button on the right side of the Backstage view.  

 

Notice the thin orange vertical line in the chart portion of the Gantt 

Chart view. This indicates the current date.  

Start Project: 

5. In the Start Date box, type 1/2/12, or click the down arrow to 

display the calendar and select January 2, 2012.  

Tip In the calendar, you can navigate to any month and then click 

the date you want, or click Today to quickly choose the current date.  

4. On the Project tab, in the Properties group, click  

        Project Information. The Project Information dialog box   

        appears.  



Start Project:  

6. Click OK to accept this start date and close the Project Information  

    dialog box.  

7. On the File tab, click Save.  

8. Locate the folder in the Project 2010 

9. In the File name box, type Simple Tasks.  

10. Click Save to close the Save As dialog box.  



Entering Task Names  

 Task names should be recognizable and make sense to the 

people who will perform the tasks and to other stakeholders who will 

see the task names. Here are some guidelines for creating good task 

names:  

•  Use short verb phrases that describe the work to be done,               

  such as “Edit manuscript.”  

• If tasks will be organized into phases, don’t repeat details     

from the summary task name in the subtask name unless it adds 

clarity.  

•  If tasks will have resources assigned to them, don’t include    

 resource names in the task names.  

Keep in mind that you can always edit task names later, so don’t 

worry about getting exactly the right task names when you’re 

initially entering them into a project plan.  



 In this section, you enter some initial tasks required for the 

new book launch events.  

  1. Click the cell directly below the Task Name column heading.  

  2. Type Assign launch team members, and then press the Enter  

       key.  

 The task you entered is given an ID number. Each task has a 

unique ID number, but it does not necessarily represent the order in 

which tasks occur. Your screen should look similar to the following 

illustration. 

Entering Task Names  



 Because this is a manually scheduled task (as indicated in the 

Task Mode column), no duration or date values appear, and the task 

does not yet have a Gantt bar in the chart portion of the Gantt Chart 

view. Later you will work with automatically scheduled tasks that 

always have duration, start, and finish dates.  

Entering Task Names  

3. Enter the following task names, pressing Enter after    

    each task name:  

• Design and order marketing material  

• Public Launch Phase  

• Distribute advance copies  

• Coordinate magazine feature articles  

• Launch public web portal for book 

Your screen should look similar to the following illustration: 



Entering Task Names:  



Entering Durations:  

 Durations—the amount of time you expect it will take to 

complete the task. Project can work with task durations that range 

from minutes to months. Depending on the scope of your project, 

you’ll probably want to work with task durations on the scale of 

hours, days, and weeks.  

Tip 

  Project determines the overall duration of a project plan 

by calculating the difference between the earliest start date and 

the latest finish date of the plan’s tasks. 

  The plan’s duration is also affected by other factors, such 

as task relationships “Linking Tasks”.  



Entering Durations:  

 When working in Project, you can use abbreviations for durations.  

 Automatically scheduled tasks always have a duration (one 

day by default). Manually scheduled tasks, You can, however, 

enter duration values for manually scheduled tasks.  

 With manually scheduled tasks, you can enter: 

1- regular duration values using the abbreviations shown     

       previously; for example, 3d for three days. You can also  

2-   text values.  



Entering Durations:  

 For the durations of days, 

weeks, and months you can use 

Project’s defaults (for example, 

20 days per month) or set your 

own values. 

 To do this, on the File tab, 

click Options, and in the Options 

dialog box, click the Schedule 

tab, as illustrated here:  

 Project uses standard values for minutes and hours for 

durations: 1 minute equals 60 seconds, and 1 hour equals 60 

minutes.  



 In this example we use the default values: 8 hours per day, 40 hours 

per week, and 20 days per month.  

 We enter various duration values for the tasks you’ve created.  

1. Click the cell below the Duration column heading   

     for task 1, Assign launch team members.  

     The Duration field for task 1 is selected.  

2. Type 1d, and then press Enter.  

    The value 1 day appears in the Duration field. Project    

    draws a Gantt bar for the task, starting at the project    

    start date you previously set.  

Entering Durations:  



 Until the tasks are linked or a specific start or finish date is set, Project 

will set all new tasks that have a duration value to start at the Project Start date. 

This is true whether the tasks are manually or automatically scheduled.  

Entering Durations:  

3. Enter the following durations or text phrases for the following    

    tasks:  

 For task 5, Coordinate magazine feature articles, you’ll enter start and 

finish dates and Project will calculate the duration. In the Start field (not the 

Duration field) for task 5, type or  select 1/16/12, and then press the Tab key. In 

the Finish field for the same task, type or select 1/24/12,    

and then press Enter  



4. For task 6, Launch public web portal for the book,   

    you don’t know a duration or start or finish date yet,   

    but you can still capture what you do know. In the    

    Start field for task 6, type About two weeks   

    before launch complete, and then press Enter.  

 

 As with the duration value of a manually 

scheduled task, you can also enter a text string for a 

start or finish date, or both. When the task is switched 

to be automatically scheduled, the text strings will be 

replaced with specific dates.  

Entering Durations:  



Entering Durations:  

 For the projects you work on in this book, the 

durations are usually supplied for you. For your 

projects, you will often have to estimate task durations. 

Good sources of task duration estimates include:  

• Historical information from previous, similar   

projects  

• Estimates from the people who will complete the   

 tasks 

• The expert judgment of people who have managed 

similar projects  

• The standards of professional or industrial 

organizations that carry out projects similar to yours  



Entering a Milestone :  

 Milestones are significant events that are either reached 

within the project (such as completion of a phase of work) or 

imposed upon the project (such as a deadline by which to apply for 

funding). Because the milestone itself doesn’t normally include any 

work, milestones are represented as tasks with zero duration.  

We can create a milestone task: 

1. Click the name of task 3, Public Launch Phase.  

2. On the Task tab, in the Insert group, click  

      Milestone.  

 Project inserts a row for a new task and renumbers the 

subsequent tasks. Project names the new task “<New Milestone>” 

and gives it a zero-day duration. As with the other new tasks, the 

milestone is initially scheduled at the project start date of January 2 

3. Type Planning complete! and then press Enter.  

    The milestone task is added to your plan.  



Entering a Milestone :  

 Tip You can mark a task of any duration as a 

milestone. Double-click the task name to display the 

Task Information dialog box, and then click the 

Advanced tab and select the “Mark task as milestone” 

option.  



Organizing Tasks into Phases:  

 It is helpful to organize groups of closely related tasks into 

phases. When reviewing a project plan, seeing tasks organized into 

phases helps you and your stakeholders think in terms of major 

work items. For example, it is common to divide book publishing 

projects into Editorial, Design, and Production phases. You create 

phases by indenting and outdenting tasks. In Project, phases are 

represented by summary tasks, and the tasks indented below the 

summary task are called subtasks.  

1. Select the names of tasks 5 through 7.  

    These are the tasks you want to make subtasks    

    of the public launch phase.  



Organizing Tasks into Phases:  

2. On the Task tab, in the Schedule group, click Indent Task.  

     Project promotes task 4 to a summary task. Or    

     you can think of it as Project demoting tasks 5   

     through 7 to subtasks; either way, the project   

     plan now includes a summary task.  



3. Select the name of task 1, Assign launch team   

     members.  

4. On the Task tab, in the Insert group, click  

      Summary.  

     Project inserted a row for a new task, indented the       

     task directly below it, and renumbered the subsequent   

     tasks. Project names the new task “<New Summary  

     Task>.”  

5. With the name of the new summary task selected, type  

     Planning Phase and press Enter.  

6. Select the names of tasks 3 and 4. You will indent these  

    tasks under the summary task 1.  

7. On the Task tab, in the Schedule group, click Indent  

    Task.  

Organizing Tasks into Phases:  



Organizing Tasks into Phases:  

Now the project plan is organized into two phases of 

work.  



Project Management Focus: Top-Down and 

Bottom-Up Planning : 

 The two most common approaches to developing 

tasks and phases are top-down and bottom-up planning:  

●Top-down planning identifies major phases or   

   components of the project before filling in the tasks   

   required to complete those phases. Complex projects   

   can have several layers of phases. This approach   

   works from general to specific.  

●Bottom-up planning identifies as many of the bottom-  

   level detailed tasks as possible before organizing them   

   into logical groups called phases or summary tasks.   

   This approach works from specific to general.  



The end 


